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Useful Tips
Here are some useful tips that will help you use this guide effectively.
1. Copy the tutorial files to a location other than the installation folder to make sure you
have read/write privileges to the files.
2. Once you start working with the tutorial file, save your work periodically!
3. Don’t stress out too much if you are having trouble with the tutorial. Call us or send us
email and we can help you out.
4. Most of all have fun!
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What's New

What's New
You can find out What's New in the latest release of AlibreCAM 2018 here:

Related Topics
What's New in AlibreCAM 2018
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Videos & Guides
Quick Start Guides for each AlibreCAM 2018 module are available in both PDF and Video
format. Refer to the following information to access these guides:

2018 Quick Start Guide Videos
AlibreCAM 2018 MILL Quick Start
AlibreCAM 2018 TURN Quick Start
AlibreCAM 2018, 2½ Axis Introduction
AlibreCAM 2018, 3 Axis Introduction
AlibreCAM 2018, 4 Axis Introduction
The Complete 2018 Video Play List
Here is a link to the complete 2018 Video Play List
How to Access the 2018 Quick Start Guide Documents
To help you quickly get started in working with each module, select one of the Help
files located on the AlibreCAM 2018 Learning Resources dialog.
You will find:
·

Data Sheets

·

Quick Start Guides

·

What's New documents

·

Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module. To access the Learning Resources dialog:
1. From the Add-Ons menu in Alibre Design, select AlibreCAM 2018 and then
Learn...
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To access the AlibreCAM Learing Resources dialog

2. Select a document from the Learning Resources dialog to get started using
the module of your choice.

Learning Resources dialog
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About this Guide

On-line help compiled on: Friday, May 4, 2018

About the MILL Module
The AlibreCAM 2018 MILL module offers fast gouge free solids/surface model machining
technology coupled with cutting simulation/verification capabilities running inside Alibre Design
for programming CNC Mills. This integration allows for seamless generation of toolpath and
cut material simulation/verification within Alibre Design, for programming milling machines
that support 3, 4 and 5 axis continuous machining.
The module also comes with numerous post-processors to output the programmed G-code
to some of the most popular machines on the market. A simple and well thought out user
interface makes this system one of the most intuitive and easy to use milling systems
available today.
You can work with the native Alibre Design data as well as use any of the data types that can
be imported into Alibre Design such as solids, surfaces and meshes. Then you can use the
AlibreCAM 2018 MILL module with its wide selection of tools and toolpath strategies to create
machining operations and associated toolpaths for CNC Mills. These toolpaths can then be
simulated and verified, and finally post-processed to the controller of your choice.

Using this Guide
If you have installed AlibreCAM 2018 successfully on your computer and are now looking at
the blank screen of Alibre Design and wondering what to do next, this is the guide for you.
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This guide will explain how to get started in using the AlibreCAM 2018 MILL module to
program a simple part through an example.
This guide will illustrate machining of a simple prismatic part such as this gasket using 2-1/2
Axis milling operations. Even though we have created a 3D representation of the gasket, it will
become apparent as we go that we can machine this using just 2D curves. The reason we
are able to do this is because of the prismatic nature of this model, which means that the
curves can be treated as the edges of vertical walls in the geometry.
This guide has two associated Alibre Design files that you can find located in the QuickStart
folder under the installation folder of AlibreCAM 2018. The first file is a completed file that
contains all of the completed toolpaths and machining operations and represents the file that
you should end up with after working through the tutorial. The other file is a starter file that
contains only the geometry. Use the completed file as a reference. Copy the starter file and
use this file to begin the tutorial.

MILLQuickStartTutorial.AD_PRT

© MecSoft Corporation
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Getting Ready
Running AlibreCAM 2018
Locate the Alibre Design shortcut on your desktop and double click to launch the
application.
Alternatively you can also click on the Windows Start button and select All Programs. Go to
the program group containing Alibre Design. (The name of this program group will usually be
called Alibre Design, unless you specified otherwise during setup.)
Once you locate the program group, select it and then select Alibre Design to launch the
application.
If the installation was successful, upon launching of Alibre Design and opening a Part
document you should observe a menu entry called AlibreCAM 2018 in the Add-Ons tab menu
bar of Alibre Design. To run AlibreCAM, drop-down the AlibreCAM 2018 menu and select
either MILL or TURN. This will display the Machining Browser on the left side of the screen.
If you do not see this menu entry then please check the On Line Help document of the
product (found in the installation folder) for help with trouble shooting the installation.

AlibreCAM 2018 only operates in the Part mode of Alibre
Design. If you are running in the Drawing or Assembly mode
of Design you will not see AlibreCAM's menu loaded in the Alibre
Design Add-Ons menu.

Machining Strategy
Main Programming Steps
The following steps will be followed in machining this model. Some of these steps will have to
be performed just once and others may have to be repeated to complete the machining.
1. Define the Machine and Post-processor to use.
2. Define the Machining Setup including Stock Geometry, Material and Work Zero.
3. Create and Select a Tool to use for machining.
4. Create the Machining Operations including the Feeds and Speeds, the Clearance
Plane and other Cutting Parameters.
5. Generate the toolpaths.
6. Simulate the toolpaths.
7. Post Process the toolpaths.
8. Generate Shop Documentation.
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Load the Part Model
The Part typically is the geometry that represents the final manufactured product.
1. Select Open from the File Menu.

2. From the Open dialog box, select the MILLQuickStartTutorial.AD_PRT file from the C:
\ProgramData\MecSoft Corporation\AlibreCAM 2018\QuickStart\ folder. As mentioned
before, it is advisable to make a copy of this part at a suitable alternative folder so that
you have write privileges to modify the part.
By default, the ProgramData folder is "hidden" from view.
Here are the steps to Show hidden files and folders:
1. For Windows7/8 users: Go to Control Panel > Appearance
and Personalization > Folder Options.
2. Select View tab and under advanced settings select Show
Hidden files and folders, clear the check boxes for:
· Hide extensions for known file types
· Hide protected operating system files (Recommended)

© MecSoft Corporation
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3. Click Apply and OK.
The part appears as shown below

MILLQuickStartTutorial.AD_PRT

In the future you can import 2D drawings, Solid, Surface
and Mesh models that are supported in Alibre Design.
3. The AlibreCAM 2018 menu item is added to the Add-Ons ribbon bar in Alibre Design.
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Load the MILL Module
Follow the procedure below to launch the AlibreCAM 2018 MILL module for Alibre Design:
1. Select MILL from the AlibreCAM 2018 menu located on the Add-Ons ribbon bar in
Alibre Design.

2. You will see the Machining Browser displayed on the left in a separate tab labeled
AlibreCAM 2018 next to the Design Explorer tab.

© MecSoft Corporation
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The Machining Browser is also referred to as the Machining Operations Browser or
the Mops Browser.
3. You can also re-size the height and width of the browser making sure that all of the
command icons and menus are easily accessible.

© MecSoft Corporation
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Define the Machine Tool
The first step in the machining process is to define the machine tool to use.
1. From the Program tab of the Machining Browser select Machine.

2. Under the Machine Tool Coordinate System tab, select the World Coordinate System
button to align the Machine Coordinate System (MCS) to the World Coordinate
System (WCS).

© MecSoft Corporation
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3. Now select the Machine Tool Definition tab and under Machine Type, set Number of
Axes to 3 Axis.

4. Click OK. The machine type now appears under Machining Job in the Machining
Browser.

Select the Post Processor
Next, we'll define the Post Processor.
1. From the Program tab select Post to display the dialog.

2. For the Current Post Processor, select Haas from the list of available posts.
3. Then set the Posted File Extension to .nc. Other file extensions are available
depending on your machine requirements.

© MecSoft Corporation
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By default, post processor files are located under
C:\ProgramData\MecSoft Corporation\AlibreCAM
2018\Posts\MILL\
The program to send the posted output data to is set to notepad.
4. Pick OK and notice that the Post type now appears under Machining Job in the
Machining Browser.
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The Setup
Machining Setup - Skip if in STD or EXP Configuration
Now let's define the Machining Setup. The Machining Setup allows you to orient the Machine
Coordinate System such that the part is aligned in exactly same way as it would be fixtured
on the machine tool for cutting.
This functionality is available only in the Professional and
Premium configurations of the product. When working with
your part files and running the Express, Standard or Expert
configuration, you will have to use the CAD tools to orient the part
geometry so that it is in the correct orientation for machining.
If in the future, if there is no Setup1 listed under your Machining Job, the system automatically
creates one when a Work Zero or an operation is generated.
However in our tutorial part, by default, the MCS (Machine Coordinate System) is already
aligned with the WCS (World Coordinate System) so this step is not required for this part.

However, in production you can have multiple setups and assign different machining
orientations for each, when running the Professional or Premium configurations.

Create Stock Geometry
In this step we'll define the raw stock from which to cut the part.
1. From the Program tab select Stock and then select Box Stock from the menu to
display the dialog.

© MecSoft Corporation
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2. Under Dimensions, set the Length L to 10.0, Width W to 6.0 and Height H to 0.125.
Note that the stock dimensions you enter are measured from the corner of the
bounding box selected in this dialog.
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The dimensions of the stock are interpreted in relation to the
corner selected in the dialog box above. For example if the
corner of the box is selected as the Bottom South West corner (as
shown in the dialog above), the Length (L) is interpreted to be along
the +X axis, the Width (W) along the +Y axis and the Height (H)
along the +Z axis.
The direction of the dimensions will change depending on the corner
selected. For example if the Top South West corner is selected,
then the Height (H) is interpreted to be along the –Z axis and so the
stock will extend below the corner.
3. Pick OK and notice that the Stock type now appears under Machining Job in the
Machining Browser.

© MecSoft Corporation
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4. If the stock does not display on the screen, select the Stock Visibility icon located at
the base of the Machining Browser.

Align Part and Stock
Once the stock model is created you can move it in alignment with the part if needed.
1. From the Program tab select Align from the menu to display the dialog. Notice that we
are working our way from left to right in the Program tab.
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2. For Z Alignment select Top and for XY Alignment select Center and then pick OK.

© MecSoft Corporation
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The stock is now aligned to the Center of the part in XY and the Top of the part in Z.

Specify Material
Next, we'll set the material for the stock geometry.
1. From the Program tab select Material to display the dialog box.

2. For Material, select Wood from the list of available materials and then pick OK.
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The material texture is now assigned to the Stock geometry. The texture is applied
when the stock model is displayed in the Simulation window.
Note: AlibreCAM 2018 uses a separate simulation window
to perform and render the cut material simulation. To bring
up this window, select the Simulate tab from the Machining
Browser and select the Window icon as shown below:

© MecSoft Corporation
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3. If the material texture does not display on the stock, select the Material Texture
Visibility icon located at the base of the Machining Browser.

Now select the Window icon

again to close the Simulation Window.
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Set Work Zero
Now that the stock is aligned to the part geometry, in this step, we will establish the work
coordinate origin also referred to as the Work Zero. The Work Zero translates the MCS origin
from the Setup to the desired location. This can be set to any location on the part or stock
geometry.
The Work Zero defines the zero point with respect to which all
toolpath points are interpreted by the controller. This would
normally be the same as the tool touch off point on the actual
work-piece on your machine. So care should be taken to make
sure that this Work Zero point defined in AlibreCAM matches the
tool zero point used on the actual work piece located on the table
of your machine.

1. From the Program tab, select Work Zero to display the dialog.

2. Select Set to Stock Box and then set Zero Face to Highest Z, Zero Position to South
West corner and then pick Generate. This sets the machine home to the top of the
stock material and the southwest corner of the stock geometry.

© MecSoft Corporation
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3. The Work Zero is now translated to the Southwest corner and top of stock material.
The Work Zero is displayed graphically when the Simulation Window
displayed.

is
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4. Also, the Work Zero now appears under the Machining Job in the Machining Browser.
Note that the Work Zero should appear as the FIRST item
UNDER the Setup in the Machining Job tree so that all
operations in that Setup will inherit that Work Zero origin.

© MecSoft Corporation
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Create Tools
To machine the above part we will now create a ½ inch (0.5”) Flat End Mill.
1. Next to the Program tab at the top of the Machining Browser, locate and select the
Tools Machining Objects button. Selecting this button toggles the Machining Objects
lower portion of the browser On and Off. Then locate the Tools tab and pick the
Create/Edit Tools icon.
These buttons and icons are shown in the menus below:
First pick the Tools Machining Objects button to make sure the Tools tab is displayed:

Then select the Create/Edit Tools icon:

2. This will display the Create/Select Tool dialog. Select Flat Mill from the Tool Type
menu at the top of the dialog.
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3. Set tool Name to FlatMill-0.5 and Tool Diameter to 0.5. Under the Properties tab set
Material to HSS and Tool Number to 1.

4. Switch to Feeds and Speeds tab and click Load from File.

© MecSoft Corporation
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5. From the dialog that displays, set Stock Material to Wood and Tool Material to HSS.
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6. Now pick OK and the computed cut feedrate and spindle speed are transferred to the
Feeds and Speeds tab of the Create/Select Tool dialog.

© MecSoft Corporation
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7. Pick Save as New Tool to save the tool. The tool is now created and listed under
Tools in Session on the left side of the dialog.
8. Pick OK to close the dialog.
You can edit the tool properties and pick Save Edits to Tool to
save the changes to this tool. To edit and save this as a New
Tool, you must enter a different tool Name.
The created tool is now listed under the Tools tab in Machining Objects browser.

In the future you can save your tools to a Tool Library. To
save Tools to a library, click Save Tool Library under the
Tools tab in the Machining Objects Browser and specify a folder

© MecSoft Corporation
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location and file name in the Save as dialog box. Two Tool Library
file formats are supported (*.vkb and *.csv). The native Tool
Library file format for AlibreCAM 2018 is *.vkb.

© MecSoft Corporation
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Machine the Inner Profiles
Now we're ready to create our first machining operation.
1. From the Program tab select 2 Axis and then Profiling from the menu of 2 Axis
operations.

This will display the 2½ Axis Profiling operations dialog. We will go over the steps for
creating the profile operation for the inner features of the Gasket.
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Control Geometry
2. Under the Control Geometry tab pick Select Curve/Edge Regions.

The Profiling operation dialog is now minimized and allows selection of features to
machine. We will now select the surface edges of the 3 inside hole features.
3. While pressing the <Shift> key, select the first hole by clicking near the upper surface
edge as shown below.

© MecSoft Corporation
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4. Now, while the <Shift> key is still pressed, repeat to select the edges of the two
smaller holes.

Now select the

icon to complete the selection.

5. The 2½ Axis Profiling dialog comes back up displaying the selected Drive Regions.
They are also highlighted on the part.
6. Notice that selecting a Drive Region from the list highlights the corresponding surface
edge curve on the part.

© MecSoft Corporation
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Cutting Tool
Now we'll select the Tool for our operation:
1. Switch to the Tool tab of the dialog.
2. Select Flat Mill-0.5 under Tools. The 0.5" Flat End Mill is now selected as the active
tool.

© MecSoft Corporation
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Note that the Tool parameters of the currently active tool are always displayed in the
status bar at the bottom of the Machining Browser.

Feeds and Speeds
Now we'll set the Speeds and Feeds for our operation:
1. Switch to the Feeds & Speeds tab of the dialog.
2. Select the Load from Tool button. AlibreCAM 2018 will retrieve the feeds and speeds
parameters that were set when the tool was defined and associate them with the
current operation.

© MecSoft Corporation
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Clearance Parameters
Now we'll set the Clearance parameters for our operation:
1. We'll switch to the Clearance Plane tab of the dialog.
2. Set the Clearance Plane Definition to Automatic and Cut Transfer Method to
Clearance Plane.

© MecSoft Corporation
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In the Automatic mode, AlibreCAM 2018 will determine a safe Z height for locating the
clearance plane. Setting the Cut Transfer Method to Clearance Plane will force all
transfer moves to be performed in this determined clearance plane.
When this tab of the dialog is active, the clearance plane is shown on the graphics
screen.
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Cut Parameters
Now we'll set the Cut Parameters for our operation:
1. Switch to the Cut Parameters tab of the dialog.
2. Set the Stock to 0. This means that we will not be leaving any thickness on the part
after machining.
3. Under the Cut Start Side section check the box next to Use Outside/Inside for Closed
Curves and then select Inside.

© MecSoft Corporation
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Alternately you could use the Determine using 3D Model option. In this case
AlibreCAM 2018 would use the 3D model to determine which side of the curve to place
the cutter for machining.

Cut Level Parameters
Now we'll set the Cut Level parameters for our operation:
1. Select the Cut Levels tab of the dialog.

© MecSoft Corporation
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2. Set Location of Cut Geometry to At Top.
3. For Total Cut Depth, enter 0.125. The cut depth is always set as an absolute value.
4. This automatically sets the Rough Depth and Rough Depth/Cut to 0.125.

Entry/Exit Parameters
Next we'll set Entry and Exit parameters for our operation:
1. Select the Entry/Exit tab of the dialog.
2. Entry/Exit parameters control how the cutter will engage material as it begins cutting
and how it leaves the material as it completes cutting.
3. Set Entry Motions and Exit Motions to None.
4. Now pick Generate.
© MecSoft Corporation

46

AlibreCAM 2018-MILL Quick Start

5. The 2½ Axis Profile toolpath is generated and the operation is listed under Setup 1 in
the Machining Browser. NOTE: Notice that it appears UNDER the Work Zero in the
Setup.

© MecSoft Corporation
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6. The toolpath is also displayed in the graphics screen.

7. Note that the display of the toolpath in the graphics screen can be turned on/off by
selecting the Toggle Toolpath Visibility icon located at the base of the Machining
Browser.

Cut Material Simulation
The new toolpath can now be Simulated to display the in-process stock model.
1. Switch to the Simulate tab at the top of the Machining Browser.
2. Select Preferences from the Simulate tab.

© MecSoft Corporation
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3. From the Preferences dialog set the Simulation Model to Polygonal and the Simulation
Accuracy to Fine and then pick OK.

© MecSoft Corporation
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Set Sim ulation Preferences

4. Then from the Simulate tab, uncheck Simulate by Moves and adjust the slider to the
left to slow down the simulation speed.

© MecSoft Corporation
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5. Now, under Setup 1 in the Machining Job tree, select the 2½ Axis Profiling operation
we just created, select the Simulation Window icon
start the simulation.

, and then pick Play to

6. You can stop the simulation at anytime by selecting the Pause button from the
Simulate tab. Subsequent to pausing the simulation, you can either choose to
continue the simulation by selecting the Play button again or exit the simulation by
selecting the Stop button.

© MecSoft Corporation
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7. To view the cut model with textures applied, select the Toggle Material Texture
Visibility icon located at the base of the Machining Browser.

© MecSoft Corporation
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Machine the Outer Profile
Now we will turn our attention to machining the outer profile of the part. Again, we will create a
simple profile toolpath, this time around the outer perimeter of the part.
1. Switch to Program tab in the Machining Browser.
2. Select the 2½ Axis Profiling operation we just created.
3. Right-click on the selected operation and select Copy.

4. Now Right-click again and select Paste.
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5. This creates a copy of the operation and places it below the original in the Machining
Job.

© MecSoft Corporation
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6. Now right-click on the second operation and pick Edit to adjust its parameters.

7. From the Control Geometry tab, pick Remove All.
8. From the Control Geometry tab, pick Select Curve/Edge Regions.
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9. While pressing the <Shift> key, select the top outer surface edge and then select the
icon to complete the selection. Note: This edge has eight (8) separate segments
so be sure to select all of them as shown in the dialog below.

10. Switch to the Cut Parameters tab and change the Cut Start Side to Outside.
11. We'll accept all of the remaining parameters and pick Generate.
12. The new 2½ Axis Profiling toolpath is generated and displayed on the graphics screen.

© MecSoft Corporation
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13. Now we'll select the new 2½ Axis Profiling operation we just created, select the
Simulation tab, select the Simulation Window icon

and then pick Play.

© MecSoft Corporation
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Post G-Code
Now with the toolpaths complete we're ready to post-process to an output text file containing
G-codes that can then be sent to the machine tool to actually machine the part.
1. Select Setup 1 from the Machining Job, right-click and select Post. This will postprocess all operations created under the Setup.

2. The Post & Save As dialog is displayed. By default, the Part file name and the Setup
name are appended for the G-code File name. Also by default, the posted G-code file
is Saved in the folder where the file was last saved.
The output file names can be controlled by setting the Posted
File Naming Conventions sections of the Set Post-Processor
Options dialog. Refer to the Select the Post Processor step for
displaying this dialog.

© MecSoft Corporation
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As you may recall we set the post to Haas back in the Select
Post Processor section of this guide. You can change the
post processor from this dialog by selecting a different one from
the drop down menu in the Current Post list. The posted G-code
by default will be saved to the folder where the part file is located.
3. Now pick Post and the G-code file is displayed in Notepad where it can be viewed or
edited manually.

© MecSoft Corporation
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4. Now close Notepad.
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Generate Reports
Information Report
At any time, you can create a Report of your Machining Operations.
1. Switch to Program tab in the Machining Browser.
2. Select Setup 1.
3. Right-click and select Information to display and Print the report.

This dialog provides an estimate of the machining time required for the operations in
the Setup.
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Note (Professional & Premium configurations only): In the future, if your Machining
Job contains multiple Setups, you can perform the same right-click sequence on the
Machining Job to determine the estimated machining time for all Setups.
4. Now pick OK to close the Information dialog.

Shop Documentation
You can also create a Setup Sheet by generating a Shop Document. This is typically used to
instruct machine operators on how to setup and machine the part on the CNC machine.
1. Under the Machining Job, select Setup1.
2. Right-click and select Shop Documentation.

3. From the Save Shop Documentation File dialog, select Template1 and pick Save.

© MecSoft Corporation
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4. This creates an HTML based Shop Document that can be viewed in a web browser.
You can select from one of the multiple HTML templates that are shipped with the
product and generate shop documentation. Each template provides varying amounts
of information. Once you have selected the Output Template and pick Save, a shop
documentation html file will be created and saved. This file can then be printed and/or
viewed in your default web browser such as Internet Explorer.
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5. Note (Professional & Premium configurations only): In the future, if your Machining
Job contains multiple Setups, you can perform the same right-click sequence on the
Machining Job to generate Shop Documentation for all Setups.

© MecSoft Corporation

64

AlibreCAM 2018-MILL Quick Start

Where to go for more help
If you need additional help please take advantage of the following MecSoft resources:
1. Quick Start Guides
AlibreCAM 2018 includes step-by-step Quick Start Guides to help you get started
using the program. You can find these and other resources on the Learning
Resources dialog.
2. On-Line Help
The on-line help distributed with the product is a great resource to find reference
information on the various functions available. You will find links to the online help for
each module and other resources on the Learning Resources dialog (AlibreCAM 2018
> Learning...).
3. Best Practices in 3 Axis Machining
This is an extended 5,000+ word original content article on The MecSoft Blog packed
full of Best Practices advice prepared by the MecSoft support staff! 3 Axis machining
is THE MOST common application for all of MecSoft’s CAM milling plugins. The
reason is quite simple. This suite of toolpath strategies can quickly and accurately
machine a vast majority of components and tooling required by industry today. In this
post we’ll explore some of the Best Practices for machining in 3 Axis using MecSoft
CAM. Read the full article...
4. Best Practices in 2-1/2 Axis Machining
2½ Axis machining is the 2nd most common application (behind 3 Axis machining) for
all of MecSoft’s CAM plugins. The reason for this is because a large number of parts
found in the real world lend themselves to 2½ Axis machining. The majority of 2½ Axis
components are simple prismatic shapes composed of drilled holes, flat horizontal
faces and straight or drafted verticals walls. Read the full article...
5. MecSoft.com Resources Page
You can find learning materials and industry resources on the MecSoft.com
Resources Page.
6. Free Videos
You can visit the MecSoft Corporation YouTube Channel to watch videos. Note that
the functionality of MecSoft's CAM products is very similar across each of the different
platforms that we support!
7. MecSoft Blog
You can visit the MecSoft Blog for short articles about using our products.
8. Case Studies
You can also visit our real-world Case Studies page to learn how others are using
MecSoft products in their workshops.
9. CAMJam Video Archive
If you are an active AMS (Annual Maintenance Subscription) user, you have free
access to our CAMJam self-training video archive and companion guide containing
over 80 videos from our support staff on every aspect of AlibreCAM 2018. If you are
new or have recently signed up for AMS, this document will show you how to access
your CAMJam archive. Want to sign up for AMS? Just give a call at 949-654-8163
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(select Option 1 for Sales).
10. Support Forums
If you are an active AMS (Annual Maintenance Subscription) user, you have free
access to our Premium Support Forums where you can discuss projects with other
experienced users that eager to assist. If you are new or have recently signed up for
AMS, this document will show you how to access the Premium Support Forums.
Want to sign up for AMS? Just give a call at 949-654-8163 (select Option 1 for Sales).
11. Knowledge Resources Forum
If you are an active AMS (Annual Maintenance Subscription) user, you have free
access to the Knowledge Resources Forum (part of the Premium Support Forums)
where you will find additional tutorial documents and source files such as The F1 CO2
Racer Body Tutorial and The Cutting Tools Workbook. If you are new or have recently
signed up for AMS, this document will show you how to access the Premium Support
Forums. Want to sign up for AMS? Just give a call at 949-654-8163 (select Option 1
for Sales).
12. MecSoft Support
If you need additional help, or if you have any questions regarding AlibreCAM 2018, you
may contact us via e-mail at support@mecsoft.com or our online support page.
13. On-Demand Training
MecSoft Corporation offers On-Demand Training as well as personalized full day
training sessions. Please look up our website or email us at sales@mecsoft.com for
further details
14. Product Page
Please do continue to visit the AlibreCAM 2018 product page to learn about the latest
updates and additional help material.
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